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Who We Are How We Can Help
* Have worked exclusively with  MIP Maintenance & Support Plans
nonprofits since 1991 * Unlimited access to JMT expert support team

« Team of former nonprofit * Monthly training webinars

professionals passionate about
helping you achieve your mission e Implementation for MIP Modules and other solutions

e Discounts on solutions and services

* Top MIP Partner « AP Automation, FP&A, and more
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Introduction

Lucy Brennan:
0 Masters in Business Administration

0 Over 27/ years experience in management accounting

0 10 years experience in MIP




* Customizing / Optimizing your Workstation
* MIP Magic (Tips and Tricks)
* Basic Reporting

* Please do keep in mind that during demonstration, your instance of MIP may look different from
what will be displayed during this session due to security settings and/or modules purchased.



Customizing / Optimizing
Your Workstation



« Make Sure Navigator, Help Menus Benefits:
and Process Manager are all turned
on under the View Menu.

e Puts all the functions, forms,
reports and help menus you
are responsible for at your

 Click on Help & Support fingertips!

* Set your Default Startup Page for MIP .
* Great for new employees in

your department!



Customizing / Optimizing Your Workstation

« Make Sure Navigator, Help
Menus and Process
Manager are all turned on
under the View Menu.

% File Edit View Maintain Timesheets Transactions Activities Reports Dashboard Organization Security Sy

v Navigator
= v Process Manager
v Help Links

Show Windows i

Refresh

Reset to Default View

n Form View

«+ Training Center

++ Related Products

®  Submit Product Enhancement

. Contact Us:

®  Training : 1-877-879-0456
® Sales:1-800-647-3863
@ Support: 1-800-945-3278

i

®  Customer Support Resources
®  MIP LiveConnect
®  SupportChat

[ fRENin ]

[*] MIP Community

Default page upon startup
Help and Support v




Customizing / Optimizing Your Workstation

* Click on Help & Support

* Set your Default
Startup Page for MIP

ocial Service Agency - Sage Fund Accou

———
Help and Support .'
*  Resource Center
* Related Products

o pport Quick Guide
Customer Support: 1-800-945-3278
Chat Suppor

Support

Sage LiveConnedt
nﬂawc«mn
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Customizing / Optimizing Your Workstation

UL Accounting for NPS Training Organization - Abila MIP - [Accounts Payable]

@ File Edit View Maintain Timesheets Transactions Activities Reports Dashboard Organization Security System Options Window

[Navigator

MIP ADVANCE Learn more

Accounting

Dashboard

g ~|

Accounting Setup

Basic Transactions

Accounts Payable

Accounts Receivable

Allocations

Budgeting

Encumbrances

Fixed Assets

Purchasing

Sales Order Entry

Session Manager

GASB Reporting

Report Manager

i~ Administration

+ Payroll

- Requisitions

Help and Support

Charting

Accounts Payable

[a— =

Enter Select
Invoices Inveices To Pay
Enter Credits

Invoices must be
available for selection.

>\ Maintenance

Vendors

Pay
Selected Invoices

o

Enter Manual
Checks

z Related Tasks

Disbursement Checks

Unposted Disbursement
Checks

Cash Disbursements
Order Checks and Forms
Spoil Checks

| Process Manager

Create
Unposted EFT Payments
Checks
O
Post Transactions

Veid Checks and Payments
Cancel Void Checks and Payments
Vendor Balances

Vendor 1089's

Forms Designer

<
*/Fa\writ'é Reports | ¥ Forms |
| Help Links

2] | ists
1 Check/Voucher Register
=2 Journals

=1 Cash Journal

=1 Expenditure Journal
=2 Transaction Reports

] Posted General Ledger Transactions

—

1 Reports - Accounts Payab
#71 Reannrte - Arcarin

etail A/P Ledg

avahle - Invnires Salact

PROCESS MANAGER

Accounts Payable Help System
Accounts Payable Checklists
Accounts Payable FAQs
Electrenics Funds Transfer for Accounts Payable Help System
Electronics Funds Transfer for Accounts Payable Checklists

\

Electrenics Funds Transfer for Accounts Payable FAQs
Forms Designer Help System

Forms Designer Checklists

Forms Designer FAQs

————— HELP MENUS

RELATED TASKS

JMT
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Customizing / Optimizing Your Workstation

- Note: These settings will be specific to the workstation.

Options > Customize Workstation Settings

NNNNNNNNNN



Customizing / Optimizing Your Workstation

’;E“QUstomize Worksutim:sgs (Accounting) [ sz |

Preferences | Alerts | Reports | Colors | User Tools |

Form Settings Application Settings .

[V]save Form Layout [¥] show Status Bar i We recommend USlng these
[¥] Clear Fields on Save [¥] Workbook Interface

[¥] show Tooltips on Bottom Buttons [¥] Always Display Screen Fonts with Smooth Edges S etti n g S .

[¥] Use Drop-Down List on Find Forms [V] Enable Sage Product Enhancement Program ¢

[V] Fill Find Forms with Records

[} view Recently used IDs

[V] Apply Offsets on Save/Post

[l Use Enter key to move between fields

[] Assume last two digits entered are cents

[ Disable auto launch of COA Wizard ¢ Save Form Layout
Records Per Page

s o) « Apply Offsets on Save/Post
* Records Per Page - 1000




Customizing / Optimizing Your Workstation

wustomize Workstatians (Accounting)

| Preferences | Alerts |Reports | Colors | User Tools|

[¥] Warning on Exit

[¥] Confirm Delete

Confirm Undo

["]warn for Invoices Due

D Warn for Recurring Entries Due

[T warn if A/P Electronic File Not Sent

* Recommended settings for
the Alerts tab.
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*S Customize Workstation Settings (Accounting)

! Preferences | Alerts I Reports | Colors iUser Tools |

[¥] Highlight Required Fields:

Table/Drop-Down List Pattern

Grouping (0 to disable): [ -
Line Shading: [ Color |
Alternate Line Shading:

Drill Down Tables

I_
Level 1: [?O_MTJ [_
Level 2: @I I—
Level 3: @ l—

Reset Colors ]

OK I | Cancel

 Customize Colors for
required fields and data
entry forms

o Apply color shading to
rows helps to see them
easier



MIP Magic (Tips and Tricks)
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MIP Magic (Tips and Tricks)

e Utilize the MIP Data Entry Quick Keys

F1 Opens Help
F2 Select Contents for Edit

F4 Opens the drop-down box on a look-up field

F5 Copies field on the line above

F6 Copies entire line above

F7 Fills in all default fields for the current line

NNNNNNNNNN



e Zoom In and Outl!

« Use CTRL + Scroll on your
mouse to zoom in or out on
data entry grids within MIP

CONSULTING



MIP Magic (Tips and Tricks)

Before Zoom

Invoice: ’test j‘ Date: 4 /27/2017 e Amount: $0.00g
Description: ’test
Vendor ID: ‘ABC j‘ Q ‘ABC Office Supply Due: 5/27/2017 %El
Check ‘Main :H 161 North Lamar
Address: Suitg 200
1099 Type: ’MISC j‘ Austin, TX 78755
Fund Grant GL Progr Dept 117 1099 Box Debit Credit
* o
Invoice: ltest j' Date: | 4/27/2017 = Amount: $0.00,
Description: ‘test
Vendor ID: 'ABC :” Q IABC Office Supply Due: 5/27/2017 %El
Check ‘Main :” 161 North Lamar
Address: Suite 200
1099 Type:  MISC__—="7] TS
,
// Fund Grant GL Progr Dept 117
\ s 101 4157001 MI
\\
\
\ /

After Zoom

JMT
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* If you are not sure if a vendor is a 1099 vendor, but need to
process an invoice (before you get a W-9 Form)

* Set that vendor as a 1099 Vendor prior to posting any transactions.
You can always remove the 1099 flag from that vendor in vendor
maintenance.

e BENEFIT: If you set them to 1099 after transactions are already

posted, you will have to make a 1099 Adjustment in the Vendor
Maintenance screen.



Vendor | Addresses | Payment and Terms | Default Coding 1099 Information ]Notes]

Issue 1099 for this Vendor [ ] Foreign Address Indicator

Proprietor Name:

Federal Tax Identification Number

() FEIN ()SSN [ (®) Applied For ] () Foreign [

Navigate to Maintain >> Vendors

« Select Vendor or click New to create a
new Vendor

e On 1099 Information tab, mark to issue
a 1099 for this Vendor

* Requires FEIN (if unavailable, select
Applied For)

CONSULTING



* Set up all your Account and Fund Offset Assignments

* Accounting Setup > Offset Account Assignments (or Maintain >> Offset Account
Assignments)

e Benefits:

* Speeds entry and accuracy of all entry screens (Accounts Payable, Accounts
Receivable & Cash Receipts).

* If you set up your Offset Assignments, all fund offsets will automatically be made
correctly as well

* If you have multiple entities/funds in your MIP database you can create offsets to
book your intercompany amounts.



MIP Magic (Tips and Tricks)

Transaction Source:

Transaction Entry Accounts
Fund:

GL:
Automatic Offset Accounts
Fund:

GL:

Due To/Due From Accounts
For the Transaction Entry Fund:

For the Offset Entry Fund:

8‘ ‘A/ P Invoices

tﬂ IOperating Fund

H‘ ‘Job Training Expense

‘v Operating Fund

t” IAccounts Payable - Vendors

@ Find INew XDelete 5Close P Help |
4

* Setup of your offset Accounts

* Use the wizard to set up offsets for

multiple accounts

JMT
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MIP Magic (Tips and Tricks)

L Accounting for NPS Training Organization - Abila MIP -
] File Edit View M

| Navigator

MIP ADVANCE Learn more

= Accounting

Dashboard

aintain Timesheets Transactions

[123 | test | Accounts Payab TCEs Session (

Activiti

s Dashboard Organization Se

Accounting Setup

Basic Transactions

Accounts Payable

Accounts Receivable

Allocations

Budgeting

Encumbrances

Fixed Assets

Purchasing

Sales Order Entry
Session Manager

GASB Reporting

Report Manager

Charting

-+ Administration

- Payroll

-+ Requisitions

Help and Support

D GoNERBLlO8EHE cElelle 0

Invoice: 123 N Date: 4 /27/2017 ‘m An
Description:  |test

Vendor ID: ’ﬁ 4@ |ABC Office Supply

Check Main e 161 North Lamar

Address: = Suite 200

1099 Type:  |MISC 7 Austin, TX 78755

Fund Grant GL Progr
*

 Use the Offset Icon during
transaction entry

* You can also have offset
populated automatically by
workstation customization and
selecting 'Save’

JMT
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MIP Magic (Tips and Tricks)

* If you are performing a process or transaction that
you are unsure about and are concerned it may be
difficult to remedy if it doesn't work correctly.....
Backup the MIP database.

 This will give the flexibility to restore the database
to a point prior to the process or transaction.

NNNNNNNNNN



* Things to know before you do this:

« Everyone MUST be out of your MIP database.

* Do not allow any users to enter any transactions in the system once your database

is backed up.
* Enter the transaction/Perform process in Question.

* If results are not as you expected, you have the ability to restore to your prior
backup point.

* Depending on your IT Hardware and the size of your MIP database this may take
some time to perform a backup. This should be done when staff can be out of
the system for a period of time.



 To Complete a Backup:
* File > Backup
* Select your MIP database
* Click Start

 To Complete a Restore:
* File > Restore
* Select your MIP Backup File
e Click Start

* Please note: This backup does not take the place of a Full Network backup!



* Set your allowable transaction dates under — Organization > Organization Preferences >

Entry Dates. This is considered a “soft close”.

rd Organization Security System
Organization Information
Organization Preferences
Add a Module...

(o0 50 i POR W 11

- BENEFIT: This eliminates the possibility of staff back-posting entries to periods that may
be closed. It also eliminates the possibility of keying a transaction in a future year or

period by accident

..............................................

Transaction Prohibit Prior To
A/P Invoices < 1/1
AP Credits 1171

CONS



MIP Magic (Tips and Tricks)

Processing Entry Dates |Session Document Numberl
N

Transaction{ Prohibit Prior To |Warn Prior To| Warn After | Prohibit After
A/P Invoices S E1 /71 /2015 12/31/2018
A/P Credits 1/1 /2015 12/31/2018
A/P Checks 1/1 /2015 12/31/2018
A/R Invoices 1/1 /2015 12/31/2018
A/R Recei... 1/1 /2015 12/31/2018
A/R Credits 1/1 /2015 12/31/2018
A/R Recei...

Budget 1/1 /2015 12/31/2018
Cash Disb... 1/1 /2015 12/31/2018
Cash Rece... 1/1 /2015 12/31/2018
Encumbran... 1/1 /2015 12/31/2018
Encumbran... 112005 12/31/2018
Journal Vo... 1/1 /2015 12/31/2018
Journal Vo... 1/1 /2015 12/31/2018
Journal Vo... 1/1 /2015 12/31/2018
Process P... 1/1 /2015 12/31/2018
Adjust Purc.. 1./ 1./2015 12/31/2018
Cancel Pur... 1/1 /2015 12/31/2018
Sales Orde... 1/1 /2015 12/31/2018
Customer |... 112015 12/31/2018
Void Chec... 1/1 /2015 12/31/2018
Void Invoic... 1/1 /2015 12/31/2018
Budget His... 1/1 /2015 12/31/2018
Encumbran.. 1112015 12/31/2018
System CI... 1/1 /2015 12/31/2018
Sales Orde... 1/1 /2015 12/31/2018

1| « [Rec Q’d 1 > /< L

JMT
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e Customize the input screens that you use frequently to your needs.

 Most grid-type entry screens in MIP can be customized to move columns into the
order you want to enter them by dragging and dropping the column headings within
the form.

« These form settings will be saved for the current workstation if you have ‘Save for
Layout’ selected under the Customize Workstation settings.



MIP Magic (Tips and Tricks)

stomize Worksutﬁngs (Accounting) x|

Preferences | Alerts | Reports | Colors | User Tools |

* This option needs to be selected in

Form Settings Application Settings
[V) save Form Layout ms""“‘” Workstatlon Settlngs to save your form
/ ve [¥] Workbook Interface

(] Show Tooltips on Bottom Buttons (7] Always Display Screen Fonts with Smooth Edges Changes,

[¥] Use Drop-Down List on Find Forms [¥] Enable Sage Product Enhancement Program

[¥] Fill Find Forms with Records

["] view Recently used IDs

[V] Apply Offsets on Save Post

[T]use Enter key to move between fields
[7] Assume last two digits entered are cents
[} Disable auto launch of COA Wizard

et e

[Restore All Form Layouts |

JMT
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S = Y] A 5] M FSETEEL ST IR L TR

Invoice: ‘ v} Date: 4/27/2017 =\ Amount: $1,000.00y

Description: |Rent

Vendor ID:  |ABC vi‘ Q  |ABC Office Supply Duye: 5/27/2017 =]

Check Main J 161 North Lamar

Address: J Suite 200

1099 Type: MISC j Austin, TX 78755

Fund Grant GL Progr Dept 1099 Box
LK 101 55001 101 101 MISC-07
01 [101 20000 ' ' MISC-07

= |
Invoice: 123 v{ Date: 4/27/2017 = Amount: $1,000.00 g
Description: Rent
Vendor ID: | ABC j‘ Q  ABC Office Supply Due: 5/27/2017 =c
Check Main N 161 North Lamar
Address: =) Suite 200

Austin, TX 78755
1099 Type:  MISC J
Fund Grant GL Progr Dept Debit
| |01 |101 |55001 [101 101 1,000.00]
01 [101 20000 0.00|

-

CONSULTING



Basic Reporting



Basic Reporting
MIP provides a many predefined reports.

Navigate to ‘Help’ for a list of the
pre-defined reports, along with a brief
description.

lom - AP - [Help and Support]

Help and Support

i+ Resource Center

4+ Related Products

{1 Contactus:

o Traning 1577479
o Sales 18008372
« Seppon: 1800945

« Sudmdt Product Enbancement

beets Famsactions Agtnities Bepects Dashbossd Orgmsitabicn Segurty Syttem Ostiens Window Hep o

View Melp
Proguct Gusdes
Orecidots
FAQs
Lt of Reperts

Ctasnng Customer Suppert..

Scbenit Product Enhsacement
What's New.

AP Customaer Commendty
AP Webote

M LveConnect

Abowt NP

-

*  Customar Sugpct Resources
o NP LveConnect
«  Scopon ot

GO0 =

[¥] MIP Community

Delaut 2ade upon s

JMT
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Navigate to ‘Reports’ on the menu across the top of MIP:
* Reports are grouped by type

5 Standard Tabs on Each Report:
* Setup, Content, Filter, Layout, Security.

 Additional tabs may also be present depending on the
type of report.

Reports

Lists
Check/Voucher Register

Journals
Transactions

General Ledger Analysis

Quick Financial Statements

Financial Statements
GASB Reporting
990 Worksheets

Assign Report Groups
Forms Designer

Report Binder

Accounts Payable
Accounts Receivable
Allocation Management
Bank Reconciliation
Budget

Encumbrances

Fixed Assets

Payroll

Purchase Orders

Requisitions

Dashboard Organization

Sed

CONSULTING



Setup Tab

 Select the report name whether it is a predefined report or one that a user created.
 Select whether the report name should be printed in the header or the footer of the report.

« Some Setup Tabs will require date information and more advanced reports will require format
to be selected.

Setup IContent[ Filter | Layout | Security |

Report Name
[COA by segment ||| [10/30/2018 7:07:03 AM
Print Name In Page Footer

(® Header (O Footer (O Do Not Print M included

CONSULTING



Basic Reporting

Content Tab — top portion

« Arrange data in report using page breaks

* Move items from the Available box on the left to the Selected box on the right

Setup Content | Filter | Layout | Security |

items by Page (Optional)
4+ ¥

Avalabie tems | Selected tems Sort Print
Segment Seguence Segment Nome |Asc ﬁSegmcn: Name - Segment Sequence
Designation Code
Form $20EZ Line Number
Form §30 Line Number >
Last Check Number

\ | . J

JMT
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Content Tab — bottom portion

* Used to determine which columns appear on the report

 Various setting options can be selected for each column such as sort order, show total, width,
wrap, repeat columns and column headings.

Report Body (Total Width: 5.60)

Available Celumns

Segment Sequence

Account Short Title

Designation Code
Designation Description
Form S90EZ Line Number
Form 990 Line Number
Last Check Number
Required Account Assignments
Stage

Award Number

Project Director

Award Type

Notification Date

Qrant Darind Start Data

»

<«

\ 4

+*
Selected Columns Sort Width Show Repeats Wra Column Heading
Account Code Asc 1.00 [] ] Account Code
Account Title None 2.00 [] Account Title
Status Asc 1.00 [] Status
Account Type Asc 1.00 [:] Account Type

CONSULTING



Filter Tab

Use this tab to narrow down and more explicitly specify the data to include in your report.

Filtering items not selected on the Content tab, the data will not labeled on the report.

Setup | Content Filter |Layout | Security

Avalable Fiter

»

«

Selected Fiter

Compares To

Criterls 2

| Segment Name

Progr
Restriction

NSULTING



Layout Tab Security Tab

Allows you to change font, style, Allows you to prevent changes to report
orientation of report

Setup ] Content] Filter I Layout Security l

oot e v “wana She Bea S
Thesthe fon "wome 0w b Son 0
T vy Page rom "oroma e bepvw dov t »
Ttlem Fem Teena tnw bagew San b S b'
Lo Loren Fom Terama yu begee Soe b ecuri Y
Lhopon boo, Fom "ware Iy begee bae b
* Ead T

[ ]Do Not Allow Changes to this Report

CONSULTING



Basic Reporting

Useful Icons:

Copy/Rename

* Allows you to make copies or rename a report

Print Report Setup

« Allows you to select which printer, number of
copies, etc.

Print Setup

 Also allows you to select orientation



Basic Reporting

Useful Icons: .
& Print to Screen

2= * Prints report to screen

Print Preview

1
i

* Provides visualization of printed report

& Print

* Prints directly to printer

JMT
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Basic Reporting

Useful Icons:

¥ = =

Export
* Allows you to select the type of file to export

Export to Excel

Export to PDF

Email Report as PDf
 Email SMTP must be set in MIP



Additional tips:

« Default reports give you a starting point so you don’t have to format your
report from scratch

* Recommendation is to use the Copy icon and make a copy of a default report

« Create as many reports as needed. Be sure the report names are easily
recognizable and relate to either how the reports are set up or who created
them.

« On content tab, between top and bottom portion, the Total Width is displayed



Questions?

JMT
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JOIN US FOR UPCOMING SESSIONS:

(links to pre-register will be included in today’s follow-up send and full agenda to be sent in coming weeks)

e June 9: Advanced Financial Statements in MIP

e August 11: Efficiencies of Using Microix Purchase Orders with MIP

JMT

CONSULTING
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Who We Are

Have worked exclusively with
nonprofits since 1991

Team of former nonprofit
professionals passionate about
helping you achieve your mission

Top MIP Partner

JMTCONSULTING.COM/CONTACT

How We Can Help

MIP Maintenance & Support Plans
* Unlimited access to JMT expert support team
* Monthly training webinars

e Discounts on solutions and services

Implementation for MIP Modules and other solutions

« AP Automation, FP&A, and more

JMT

CONSULTING
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